





AreaMan


Software Release 8.0 - Feb. 98


Freeware Windows Area Manager and Editor for MSFS


�














User Manual


and 


Operating Guide














�


©1997-1998 Central Park Informatica


(Software Technologies and Solutions)


All Rights Reserved.


Made with proud in Italy.


�
Summary


� SOM \o "1-3" �1 Introduction	� PULSVAIA _Toc411873448  � PAGRIF _Toc411873448 �1-1��


1.1 Copyright and Redistribution Notice	� PULSVAIA _Toc411873449  � PAGRIF _Toc411873449 �1-1��


1.2 Warranty	� PULSVAIA _Toc411873450  � PAGRIF _Toc411873450 �1-1��


1.3 Acknowledgements and TradeMarks	� PULSVAIA _Toc411873451  � PAGRIF _Toc411873451 �1-1��


1.4 Features	� PULSVAIA _Toc411873452  � PAGRIF _Toc411873452 �1-1��


2 Installation	� PULSVAIA _Toc411873453  � PAGRIF _Toc411873453 �2-1��


2.1 Installing AreaMan on your Disk	� PULSVAIA _Toc411873454  � PAGRIF _Toc411873454 �2-1��


2.2 Installing on a LAN	� PULSVAIA _Toc411873455  � PAGRIF _Toc411873455 �2-1��


2.3 Requirements	� PULSVAIA _Toc411873456  � PAGRIF _Toc411873456 �2-1��


2.4 Installation troubleshootings	� PULSVAIA _Toc411873457  � PAGRIF _Toc411873457 �2-1��


3 Technical Support	� PULSVAIA _Toc411873458  � PAGRIF _Toc411873458 �3-1��


3.1 Contacting us	� PULSVAIA _Toc411873459  � PAGRIF _Toc411873459 �3-1��


3.2 General advices and known bugs.	� PULSVAIA _Toc411873460  � PAGRIF _Toc411873460 �3-1��


3.3 3rd party developers.	� PULSVAIA _Toc411873461  � PAGRIF _Toc411873461 �3-1��


4 Operating AreaMan	� PULSVAIA _Toc411873462  � PAGRIF _Toc411873462 �4-1��


4.1 General overview	� PULSVAIA _Toc411873463  � PAGRIF _Toc411873463 �4-1��


4.2 Program controls overview	� PULSVAIA _Toc411873464  � PAGRIF _Toc411873464 �4-1��


4.3 Opening and saving files	� PULSVAIA _Toc411873465  � PAGRIF _Toc411873465 �4-1��


4.4 Creating new scenery areas	� PULSVAIA _Toc411873466  � PAGRIF _Toc411873466 �4-2��


4.5 Enabling or disabling single or groups of scenery files	� PULSVAIA _Toc411873467  � PAGRIF _Toc411873467 �4-3��


4.6 Assigning a title and a description to a VIS file	� PULSVAIA _Toc411873468  � PAGRIF _Toc411873468 �4-3��


4.7 Creating new performance boosters	� PULSVAIA _Toc411873469  � PAGRIF _Toc411873469 �4-3��


4.8 VIS File overview	� PULSVAIA _Toc411873470  � PAGRIF _Toc411873470 �4-4��


5 Configuring AreaMan	� PULSVAIA _Toc411873471  � PAGRIF _Toc411873471 �5-1��


5.1 The Preferences Window	� PULSVAIA _Toc411873472  � PAGRIF _Toc411873472 �5-1��


5.2 The StartUp Tab Sheet	� PULSVAIA _Toc411873473  � PAGRIF _Toc411873473 �5-1��


5.2.1 Open last file	� PULSVAIA _Toc411873474  � PAGRIF _Toc411873474 �5-1��


5.2.2 Check for FS Hinstance	� PULSVAIA _Toc411873475  � PAGRIF _Toc411873475 �5-1��


5.2.3 Create backup	� PULSVAIA _Toc411873476  � PAGRIF _Toc411873476 �5-1��


5.2.4 Cache format	� PULSVAIA _Toc411873477  � PAGRIF _Toc411873477 �5-1��


5.3 The Directories Tab Sheet	� PULSVAIA _Toc411873478  � PAGRIF _Toc411873478 �5-1��


5.3.1 Flight Simulator Directory	� PULSVAIA _Toc411873479  � PAGRIF _Toc411873479 �5-1��


5.3.2 Default .VIS file directory	� PULSVAIA _Toc411873480  � PAGRIF _Toc411873480 �5-1��


5.4 The Archiving Tab Sheet	� PULSVAIA _Toc411873481  � PAGRIF _Toc411873481 �5-1��


5.4.1 Enable area archive	� PULSVAIA _Toc411873482  � PAGRIF _Toc411873482 �5-2��


5.4.2 Compression Level	� PULSVAIA _Toc411873483  � PAGRIF _Toc411873483 �5-2��


5.4.3 ZIP Version	� PULSVAIA _Toc411873484  � PAGRIF _Toc411873484 �5-2��


6 Menu Commands	� PULSVAIA _Toc411873485  � PAGRIF _Toc411873485 �6-1��


6.1 The File Menu	� PULSVAIA _Toc411873486  � PAGRIF _Toc411873486 �6-1��


6.1.1 File-New	� PULSVAIA _Toc411873487  � PAGRIF _Toc411873487 �6-1��


6.1.2 File-Open	� PULSVAIA _Toc411873488  � PAGRIF _Toc411873488 �6-1��


6.1.3 File-ReOpen	� PULSVAIA _Toc411873489  � PAGRIF _Toc411873489 �6-1��


6.1.4 File-Save	� PULSVAIA _Toc411873490  � PAGRIF _Toc411873490 �6-1��


6.1.5 File-SaveAs	� PULSVAIA _Toc411873491  � PAGRIF _Toc411873491 �6-1��


6.1.6 File-Print	� PULSVAIA _Toc411873492  � PAGRIF _Toc411873492 �6-1��


6.1.7 File-Close	� PULSVAIA _Toc411873493  � PAGRIF _Toc411873493 �6-1��


6.1.8 File-Exit	� PULSVAIA _Toc411873494  � PAGRIF _Toc411873494 �6-1��


6.2 The Areas Menu	� PULSVAIA _Toc411873495  � PAGRIF _Toc411873495 �6-1��


6.2.1 Areas-Update	� PULSVAIA _Toc411873496  � PAGRIF _Toc411873496 �6-1��


6.2.2 Areas-Priority	� PULSVAIA _Toc411873497  � PAGRIF _Toc411873497 �6-2��


6.2.3 Areas-Disable/Enable	� PULSVAIA _Toc411873498  � PAGRIF _Toc411873498 �6-2��


6.2.4 Areas-Delete	� PULSVAIA _Toc411873499  � PAGRIF _Toc411873499 �6-2��


6.2.5 Areas-New	� PULSVAIA _Toc411873500  � PAGRIF _Toc411873500 �6-2��


6.2.6 Areas-Zip Area	� PULSVAIA _Toc411873501  � PAGRIF _Toc411873501 �6-2��


6.2.7 Areas-Zip Area	� PULSVAIA _Toc411873502  � PAGRIF _Toc411873502 �6-2��


6.2.8 Areas-Search	� PULSVAIA _Toc411873503  � PAGRIF _Toc411873503 �6-2��


6.3 The Boosters Menu	� PULSVAIA _Toc411873504  � PAGRIF _Toc411873504 �6-3��


6.3.1 Boosters-New	� PULSVAIA _Toc411873505  � PAGRIF _Toc411873505 �6-3��


6.3.2 Boosters-Delete	� PULSVAIA _Toc411873506  � PAGRIF _Toc411873506 �6-3��


6.3.3 Boosters-Set CD Path	� PULSVAIA _Toc411873507  � PAGRIF _Toc411873507 �6-3��


6.3.4 Boosters-Update	� PULSVAIA _Toc411873508  � PAGRIF _Toc411873508 �6-3��


6.4 The Options Menu	� PULSVAIA _Toc411873509  � PAGRIF _Toc411873509 �6-3��


6.4.1 Options-Preferences	� PULSVAIA _Toc411873510  � PAGRIF _Toc411873510 �6-3��


6.5 The Help Menu	� PULSVAIA _Toc411873511  � PAGRIF _Toc411873511 �6-3��


6.5.1 Help-About	� PULSVAIA _Toc411873512  � PAGRIF _Toc411873512 �6-3��


��
Introduction


NOTE: unexperienced users should read Chapter 4 (Operating AreaMan) for a first overwiev of available features in AreaMan. Both experienced and unexperienced users may read CHANGES.TXT for a list of bug fixes and ehnancements.


Copyright and Redistribution Notice


AreaMan is © by Alessandro Antonini (F.I.V.S. I-ANTO) and Central Park Informatica.


It may not disassembled, reverse engineered or decompiled, either totally or partly.


It may not be used for unlawful purposes or under unlawful environments.


This document and this Copyright notice may not be altered, so may not the whole rest of the archive contents.


It is a freeware tool and may not be sold nor be included into any disc/CD collection without my prior written approval. If it is to be included into a shareware / commercial collection be aware i might require a fee up to but not exceeding USD 100, payed in advance. If you feel i shouldn’t be at least a bit rewarded for contributing to your gains, then don’t distribute this software at all.


It may not be uploaded to, nor archived in Compuserve FsForum, due to CopyRight use, misuse and abuse by that site’s managers.


It may not be uploaded to, nor archived in PVI BBS and any site related to it.


Not excluding the above, it may be freely uploaded to and distributed by any Bulletin Board or Internet Site, providing no fee is required upon its download.


Warranty


As this software is being released under the freeware concept we can’t offer any warranty except it’ll take up disk space and release it  when deleted. We are also not to be held liable for anything you may run into by using this software nor we are obliged to release any update or fixes. As best as it concerns we’ll try to help anyone which needs to, either by E-Mail or through or Web Page (see Contacting Us ON Technical Support section).


Acknowledgements and TradeMarks


This program extensively uses controls and components from the RX Library v.2.32 by Master-Bank, Russia. That is a very good library (perhaps the best freeware one) and if you are interexted in it, I have a link to current version on my WEB Page.


Thanks to Jordan Russell for such a great docking toolbar component. May be found on Delphi Super Page (Italian mirror at http://www.programmers.net/mirrors/DSP/), name: TB97_153.ZIP.


AreaMan uses routines from DELZIP12.ZIP by Eric Maesser, including ZIPDLL.DLL and UNZDLL.DLL,  for handling the area compression features. May also be found at Delphi Super Page.


The checkbox component may be found in DTOOLS31.ZIP (nice library). Don’t remember author’s name but it’s as well available on D.S.P.


Further informations on ZIP and GNU InfoZip archive internals are to be found at InfoZip home page, at http://www.cdrom.com/pub/InfoZip/


Microsoft Flight Simulator™, is © by Bruce Artwick and Microsoft Corporartion.


Features


What is Areaman? It is an editor for all those scenery area installed into Flight Simulator. Installed scenery areas are being stored in a file commonly called WORLD.VIS. AreaMan will take care of working on this kind of files and has some convenient features over the built-in area manager of Flight Simulator.


First it works externally from Flight Simulator. That means that you can work over your WORLD.VIS while FS is not running. If you have problems with a scenery file you may either disable it or the whole scenery area it belongs to, so that you don’t have to reinstall FS each time a problem arises.


Anything is done within a single window, either area scrolling or single area editing. You don’t have to walk through hundred of menus as you have to do with FS built-in editor. This will speed up operations quite a lot.


Windows-Explorer-like environment, with the list of installed areas being displayed in a treeview on the left pane of the main window and details on right.


Both Manual and Automatic area layers rearrangement.


Performance Boosters management with just all the features you need to.


Compression of less used areas in a single ZIP file to save up on disk space. Select the area you want to compress and AreaMan will do the rest. Creates a ZIP file compatible with PkZip 2.04, WinZip and GNU InfoZip.


Automatic searching and adding of scenery areas from drives on your disk. Install new scenery areas in just a snap.


Maximum configurability to just satisfy almost all of your needs, as in our programming style. Nothing is left to chances.


SuperFast! AreaMan engine has been totally rewritten using the maximum care and code is incredibly optimized. I have optimized the code so much that, while the visual aspect is improved a lot, it even requires less space and memory than before.


And last but not least, get the best of our knowledge and technology for no cost at all. AreaMan is, just like any other software produced by Central Park Informatica, totally freeware with NO stupid nags and cripples. We are looking for a way to provide you with quality software, and by no means we are looking for charity.


�
Installation


Installing AreaMan on your Disk


There’s nothing easier. Just uncompress the distribution package in a temporary directory and run the setup program (click on setup.exe or type it in a dos prompt box), then follow the instructions on screen. Anything will be automatically set for you. All files are named using the MS-DOS standard 8.3 convention, therefore you may uncompress SFL package using either PKZIP, WinZip, InfoZip or any of the many uncompression utilities available, as long as they are compatible with PkZip 2.04 format.


NOTE: if you have previous versions of AreaMan installed, you should delete CPLIST32.DLL from your WINDOWS\SYSTEM directory. Starting this version AreaMan doesn’t need this file any longer.


Installing on a LAN


This has not being tested, but any lan installation should complete just as fine.


Requirements


AreaMan is a WIN32 GUI Mode application. You’ll need either Windows 95/98 or Windows NT 4.0 or higher to be installed. It requires about one megabyte of disk space and should work decently with 8 Mb RAM.


Installation troubleshootings


First check you haven’t downloaded a corrupted package version. In this case, try to repeat download and installation. If this doesn’t help, just contact us (please read Chapter 3 - Technical Support for details).


�
Technical Support


Contacting us


In case help is needed, just contact us on the Internet. We have a MailTo link from our home page which is located at: http://members.tripod.com/~theflyguy/


Please, try to be meaningful. Terse explainations, such as: ‘AreaMan doesn’t seem to start at all’ or ‘I can’t find the power outlet to plug my machine on’, won’t help us much to help you.


If possible, pay attention to any exotic message the program will exit with. The execption handler has been programmed with the final user in mind therefore error messages will be hopefully somewhat meaningful. In case of GPF or Kernel32 errors, just click on the ‘Details’ button of the Error box Windows will show (this program has executed an invalid instruction etc. etc.) and send us its contents. This will equal to have a snapshot of the memory state at the time of the error.


However, AreaMan has been by the way carefully tested and after 8 releases is enough error-proof, hence you shouldn’t occur in many probles using it.


General advices and known bugs.


If Microsoft Internet Explorer 4 is installed, chances are the parent folders displayed on area and booster left pane displaced tree view will have their glyphs overlapped by a red X (the red unchecked mark). This doesn’t happen with previous releases of IE. Something must have changed in COMCTL32.DLL.


If possible avoid to use Windows 95 long file names for scenery directories. FS will work just fine even with short file names, and paths will be easier to remember. Besides, a VIS file has a size limit of 64 Kb, and very long directory names might be easily let you reach this limit.


3rd party developers.


We should release AreaMan engine soon as a DLL, thanks to it, it will be easy to incorporate VIS file management in own applications.


�
Operating AreaMan


General overview


Operating with AreaMan should be easy and self intuitive even for the less experienced user. Besides, i hope this documentation is detailed enough. You work in the standard Windows 95 GUI interface. Any command available to end user may be accessed from menu and the most commonly used have their shortcut on tool bars. Areaman main toolbar may be docked and undocked in and out of main window anytime and scenery list small toolbar may be dragged at the four edges of file list window instead. Working with different screen resolutions shouldn’t be a big problem and further on, Areaman window size and state will be always stored and reused on next run. Multiple copies of AreaMan can be run with no problems, anyway they all will be sharing the same settings, which are stored in the Windows registry.


Program controls overview


Main window is divided in three sections: Menu, Installed Areas and Boosters Lists and single Area and Booster Management. Since it is a “manager” of something then it’s natural to think of it as a sort of File Manager. Therefore view controls are implemented a way that resembles Windows Explorer. List of all installed boosters and areas are displayed in a Tree View on the left pane of main window and single area/booster management  are displayed in a list view on the right. Main Menu is located up north of them just below the main window caption bar. Just below the Menu Bar takes place a button tool bar with shortcuts to the most used commands. Buttons are draw in a flat view, like Internet Explorer, and they highlight when users drops mouse over them.


Access to different sections of currently loaded file is given by switching the three tab sheets (Areas, Boosters and General). That should be obvious and self explaining, though.


When focus is on the left pane of window, area and booster tree views command can be accessed by a context menu activable with a right mouse button click. They include commands to manage area or booster items which are explained in detail below.


The right pane of the window has a command panel for areas and boosters and a File List view that will list selected Area contents. Scenery list can be viewed as Icon, Small Icon, Report or List mode, by clicking on the relative icon of the small toolbar. BGL file(s) may be enabled or disabled  so that Flight Simulator will load them or not. That is a particularly useful facility in case you have troubles finding faulty BGLs that would prevent Flight Simulator from running correctly. Select the BGL(s) to be made inactive and either click on the Disable/Enable icon of  File List toolbar or right click with mouse to open the File Enable/Disable context menu. This will be accomplished in a very simple way: AreaMan will just change file extension to BGD (for example MYSCENERY.BGL becomes MYSCENERY.BGD and viceversa).


The left pane of the Window lists the installed Scenery Areas or CD performance boosters. Scenery Areas are grouped under three parents folder groups: Global Area, Regional Areas, and Local Areas. Note that Scenery Builder High and Scenery Builder Low are not supported by Areaman, which will read them and convert them to Local Area type on the fly. That was a feature available only with FS5.1 and however, scenery converted to Local type will work just fine even under FS5.1.


After a file has been loaded and ready for editing, both Area and Booster Items may be enabled or disabled by either using Menu commands or by double clicking with left mouse button or finally by right clicking with mouse when mouse pointer is over Area/Booster tree list and opening the relative context menu.


Opening and saving files


Just like any other editor, AreaMan keeps track of changes made to current file and will prompt User to save it if he terminates application or opens another file. For each saved file, a “create-backup” might be enabled or disabled from the Preferences dialog box. If backup create is enabled, then the original file will be saved as PATH_TO_VIS\FILENAME.BKP. It is strongly adviced user leaves this feature enabled so to restore it back in case something goes wrong.


Files may be open in several ways:


by associating VIS file types with AreaMan (see your Windows documentation / online help for further details) and double clicking on them in Windows Explorer;


by dragging and dropping a VIS file icon over Areaman icon;


by launching it from command line, in a Windows text Mode box (that’s from console). (Ex.: AREAMAN.EXE D:\FS98\SCENERY\WORLD.VIS);


by opening it once program is loaded, using the Open File command.


Last worked file may be automatically reopen on the next run. There is an option box in Preferences Menu to enable or disable file automatic reopen capability. Besides, users can quickly access to the recent 10 files by shortcuts placed on File->Reopen submenu.


Creating new scenery areas


This will work only if a file is open.


Click on the Area tab sheet to ensure Area commands panels and menu become available.


Choose Areas->New menu command or click on “Create new area” from Main Window Toolbar (that is actually the blue single floppy 3D icon. If an area is selected for view/editing then the BGL file list should clear, so should scenery path and title edit boxes. Window focus will be set to scenery path edit box (cursor will flash overthere).


Type the path where the area physically resides on disk (Ex: F:\SCENERY\HONGKONG) or click on the Browse button located right of the edit box. Usage of a trailing slash is not necessary. May be anywhere on disk, but read below.


Any scenery area is so composed:


a main area directory, example F:\FS98\MYSCEN\


two subdirectories named SCENERY and TEXTURE





Therefore we have this scenario: 	F:\FS98\MYSCEN\SCENERY


	F:\FS98\MYSCEN\TEXTURE


SCENERY subdirectory contains scenery files (those with BGL extension).


TEXTURE subdirectory contains texture files (generally they have a R8 extension).


These two subdirectories must never be used as the Area Path. Parent directory (in this case F:\FS98\MYSCEN) must be chosen instead.


Type the title of your new area (Example: New Mexico Scenery) in area title edit box.


Choose a scenery type for your area. For 3rd party scenery it must be always Local type. Regional type should be selected for FS scenery on CD and default scenery (those BGLs placed in main SCENERY directory) only. Global type is reserved exclusively for default World synthetic tiles and elevations and nothing else.


Click on the Enable box if you want your area to be immediately being made active.


Finally, click on the Update button. This will add the new area to Area List, placing it on top. That means that it will have by default the highest layer priority. You may lately choose to decrease/increase back its layer priority by using the Area Priority commands. Note that this will not save changes to file, but it will save changes in memory only. If you don’t save file on terminating your editing session, changements will be lost. When file is saved then changements becomes permanent.


Enabling or disabling single or groups of scenery files


If there are troubles with a BGL file, AreaMan provides a facility to disable single or group of BGL files so that to make it easier to locate them and behave by consequence.


When the focus is on Scenery list view on the right pane of Main Window:


Select desired list view style (you can choose among Report, Icon, List and Small Icon views).


Highlight the BGL(s) to be disabled or enabled.


Click on the Red Uncheck Mark icon of List View small toolbar to disable. To enable, click on the Green Check Mark icon instead. Enable/Disable commands might be also executed by opening List View context menu with a right mouse button click. Multiple BGL files may be selected for enabling/disabling the same way as Windows Explorer.


When a file is to be disabled, AreaMan simply changes its extension to BGD. While this doesn’t delete it from disk (therefore being available at any time), Flight Simulator will ignore and not load it. At the time or re-enabling, AreaMan changes file extension back to BGL





Assigning a title and a description to a VIS file


This can be done by clicking on General tab sheet and entering title and description in their relative edit boxes. When User saves file, then the new title and description will be permanently stored in the VIS file. If there are no files loaded then these controls will be read-only. When editing title and description it is possible to copy contents to clipoard (or paste from) by opening the edit boxes context menu with a right mouse click.


Creating new performance boosters


WARNING: to accomplish this operation it is assumed user has a scenery on a CD ROM and a destination path on hard disk with BSTINFO and BSTINFO.DLL relative to that CD scenery. Otherwise Flight Simulator will behave abnormally. In any case this operation should be done by experienced users only.


Click on the Booster tab sheet to ensure Booster commands panels and menu become available.


Choose Booster->New menu command or click on “Create new booster” from Main Window Toolbar (that is actually the blue single floppy 3D icon - when Booster tab sheet is active, this button will control boosters instead of areas). If a booster is selected for view/editing then CD and Disk path will clear. Window focus will be set to CD path edit box (cursor will flash overthere).


Type full path to the CD containing your CD scenery (Example: H:\SAMERICA) or click on the Browse button rightmost of CD edit box to browse the disk directories tree.


Type full destination path on disk in the disk path edit box.


Set a minimum cache size for your booster (reasonable value should be between 5000 and 10000)


Set the cache update strategy to desired value (refer to paragraph 4.6 below for further details)


Set the way you want FS to clean cache on exit (again refer to paragraph 4.6).


Choose the CD booster status by clicking on the Enabled checkbox.


Finally, click on the Update button. This will add the new Booster to Booster List. Note that this will not save changes to file, but it will save changes in memory only. If you don’t save file on terminating your editing session, changements will be lost. When file is saved then changements becomes permanent.


Ensure there is a Scenery Area installed in Area List for this booster. Area type must be set to Regional and Area path must be the same as booster destination path on disk. Do operation described at paragraph 4.4, eventually.


VIS File overview


A VIS file (e.g. WORLD.VIS) is composed by 4 different sections and has a rather simple format:


A header, containing informations about where in the file other three sections are stored and on the file type and size. NOTE: a VIS file may have a maximum size of 64 Kb.


A booster assignment section. Flight Simulator uses it to store informations about CD Boosters Titles. Other informations on boosters are stored in two special files called BSTINFO and BSTINFO.DLL placed on each booster directory. NOTE that a CD performance booster will not work unless these files exist in their directories. In this case AreaMan will rename the booster description to “Missing BSTINFO”.


A list of all areas installed section, this include path and description of installed scenery areas along with information of area status and type (Global, Local and so on). Starting from FS5.1 a layer priority mechanism has been introduced, in order for scenery having a higher priority to overlap scenery having a lower priority. The first element of the list has a higher priority than the second, second has a higher priority than the third and so on.


A list of installed cache performances boosters. Flight Simulator will copy CD scenery on a destination path on Hard Disk to speed up loading operations. CD area scenery and textures are read from CD-ROM and written to the destination disk in "cache" for fast access. New scenery from CD-ROM is loaded as Users moves into new areas The boosters contains the Source path on CD and Destination path on Disk Along with:


a cache size (the amount of kilobytes to be transferred of disk). If destination path has a file named BSTINFO, then upper and lower bound is automatically determined by AreaMan.


informations on the booster status (active or not)


information on whether cache should be clean or not upon exit. If this switch is active then FS will delete BGL files and textures that was cached on disk when it terminates. Disabling this switch should reduce disk access and is indicated in case User flies frequently over the same cached area.


Information about cache update strategy. Might be automatic, semi-automatic or manual. In Automatic mode, FS will automatically update cache from CD. In Semi-Automatic User would be prompted whether he/she wants to update cache or not when needed. In Manual mode update is disabled unless User executes the Cache restart command in FS.


�
Configuring AreaMan


AreaMan Settings may be accessed by executing Options->Preferences menu command.


The Preferences Window


Preferences Window is separated into three distinct sections: Startup, Directories, Archiving. They are grouped in a tab sheet control and tab pages may be accessed by clicking on them with mouse.


The StartUp Tab Sheet


It’s used to configure startup settings (options that will be set upon AreaMan startup).


Open last file


When this option box is enabled AreaMan will automatically open last file edited during the former session. If User uses to work on the same file all the times, then he/she should leave this Option checked.


Check for FS Hinstance


When this option box is enabled AreaMan will check whether Flight Simulator is running and in this case it will prevent User to access commands that might be otherwise be dangerous to execute while FS is active, such as deleting or adding areas and boosters, compressing and uncompressing areas and so on. User is recommended to leave this option checked unless he/she knows what he/she is doing. Note that FS Hinstance checking only works with FS version 6 or later.


Create backup


This option box enables backup creation of VIS files. The old file is saved in the same directory as the saved file, with BKP extension. User is recommended to leave this option checked, so that old file may be easily restored, should problems arise.


Cache format


This let user specify which kind of cache system should be used (FS5.1 or FS6 and later), since the cache system differs when setting cache size.


The Directories Tab Sheet


It’s used to tell AreaMan where to find system and data directories.





Flight Simulator Directory


This tells AreaMan where FS directory is located (Example: C:\FLTSIM98). Must be the same as the FS main executable. This path is mandatory and must be a full valid path.


Default .VIS file directory


This tells AreaMan where to start looking for VIS files when opening them. That should normally be the main Scenery directory (Example: C:\FLTSIM98\SCENERY).


The Archiving Tab Sheet


It’s used to configure area archiving capabilities.


Enable area archive


This will enable Area Archive. When this box is unchecked, Area Archiving commands will have no effect.


Compression Level


Range 1-9 - this sets the compression factor to use. It ranges from 1 (No compression at all, just storing), to 9 (Maximum compression). The higher the compression level is, the slower the archiving operations will be. As a good compromise between speed and compression, this should be set at 5/6.


ZIP Version


This is the ZIP DLL version number. For current release, this should be set at 120. It is recommended to never change this value unless a later version of ZIP DLL is being installed, or abnormal behaviour might occur.


�
Menu Commands


The File Menu


File-New


This command lets User create a new VIS file from scratch. VIS file will be created using default settings same as FS built-in editor. AreaMan will create predefined areas as it needs to be and an empty booster list. New areas or boosters can lately be created using Area/New - Booster/New commands. See  paragraphs 4.4 and 4.5 for details.


File-Open


This command lets User create a pre-existing VIS file. A File Open Menu will let User choose the VIS file to edit. Default file extension is *.VIS.


File-ReOpen


Whether a file is being closed or User terminates application Areaman stores a list of last recent files being used. This menu will let User access to shortcuts to the last 10 used files for opening back.


File-Save


This lets User save any changes done while editing a VIS file. By default, Areaman creates a backup file of the original file. Backup extension defaults to *.BKP. Backup file generation can be disabled from the Prefences Menu.


File-SaveAs


This will save current file with another name. Changements to original file will not be saved, instead they will be saved to the new named file.


File-Print


This will Print a report of current file. Options are to Print report either to a text file or to your Windows printer.


File-Close


This will Close current file. User is prompted to save changes, if any.


File-Exit


Terminates program. User is prompted to save changes, if any.


The Areas Menu


NOTE: Areas commands are being disabled when main window tab sheet active page is not Areas. It is being enabled back when user highlights it again.


Areas-Update


For each single area being changed, this will let User update changements. The same command may be executed by clicking on the Update Button on Area command panel. Note that this only save changes in memory. File must be saved with File-Save command prior changes to be effective.


Areas-Priority


This will open a sub menu containing commands to manage up area layers. They are:


Increase	this will increase selected area priority and will cause its scenery files having a higher layer over the belowstanding areas ones;


Decrease	this will decrease selected area priority and will cause its scenery files having a lower layer than the upstanding areas ones;


Arrange	this will automatically arrange area layers, same way as built-in FS Scenery library editor.


Areas-Disable/Enable


This will disable currently selected scenery area and will prevent Flight Simulator from loading it. Executing this command once more will enable area back. The same command can be executed by double clicking on the selected area or by opening Area context menu with a right mouse button click when focus is on Area TreeView 


Areas-Delete


This will delete currently selected scenery area from Area List. Note that Area directory with scenery and textures is not removed from disk. User is prompted to confirm operation. If changements are saved, then Area will be definitively removed from VIS file. Use this command with care. The same command can be executed by opening Area context menu with a right mouse button click when focus is on Area TreeView or by clicking on Delete area button (that is the one with a TrashCan icon) on toolbar.


Areas-New


This will create a new scenery area. Detailed instructions on how to create a new area can be found at paragraph 4.4. This command may also be executed by clicking on Create new area button on toolbar.


Areas-Zip Area


When this command is executed, AreaMan will compress the selected area scenery and texture files into a ZIP archive, so that to save on disk space. When ZIP operation is completed, Seleted area status will be set to disabled. This is a particularly useful command in case User has Areas on disk he/she seldom flies over. 


ZIP created archive will be named SCENARCH.ZIP and placed on scenery area path. The same command may also be executed by opening Area context menu with a right mouse button click or by clicking on the ToolBar ZIP Icon when focus is on Area TreeView.


Areas-Zip Area


If an area has been compressed, executing this command will uncompress it back into its original directories. When uncompress operation is terminated, AreaMan will prompt User whether he/she wants to delete the compressed ZIP package. The same command may also be executed by opening Area context menu with a right mouse button click or by clicking on the ToolBar UnZIP Icon when focus is on Area TreeView.


Areas-Search


This will search for scenery areas, more or less like the FS built-in scenery manager. A window will open and user can choose drive where to start search from. For any new area it will find, AreaMan will ask User a title for it, a Scenery type and whether new area should be made enabled or not. At this point User has three choices: Adding the new area, Skipping to the next one or Abort searching. This command may also be executed by pressing CTRL+F when active tab sheet is Area.


The Boosters Menu


NOTE: Boosters commands are being disabled when main window tab sheet active page is not Boosters. It is being enabled back when user highlights it again.


Boosters-New


This will create a new booster. Detailed instruction on how to create a new booster can be found at paragraph 4.5. This command may also be executed by clicking on Create new area button on toolbar.


Boosters-Delete


This will delete selected booster. As of with Areas-Delete User must pay attention at what he/she is doing! This command may also be executed by clicking on  Delete booster icon on toolbar or by right clicking with mouse when focus is on booster Tree View.


Boosters-Set CD Path


This is a facility for those Users whose CD drive letter changes often (E.G. they have a removable drive like a Iomega Zip, which installs before CD). Executing this command will open a browse dialog box where User may choose his/her CD path. Upon closing the Browse Dialog AreaMan will set the correct CD Drive letter for all installed CD Boosters. This command may be also executed by clicking on the CD-ROM icon of the toolbar.


Boosters-Update


This will update changements made to a booster. The same command may be executed by clicking on the Update Button on booster command panel. Note that this only save changes in memory. File must be saved with File-Save command prior changes to be effective.


The Options Menu


Options-Preferences


This will execute the preference Window from where User may configure AreaMan. Setting AreaMan options is discussed above on at Chapter 5 - Configuring AreaMan


The Help Menu


Help-About


This will execute the About box where User may be obtain Program Informations and Memory status. It also contains commands that will allow User to launch the WEB browser (Internet Explorer/NetScape) to connect to our Site, or a MAPI compliant Mail Editor (e.g. Pegasus Mail) to send Mail to us.
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